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Introduction

This manual describes how to connect the Display and the External Device (target PLC).

In this manual, the connection procedure will be described by following the below sections:

1 System Configuration

This section shows the types of External 

Devices which can be connected and SIO 

type.

"1 System Configuration" (page 3)

2 Selection of External Device

Select a model (series) of the External 

Device to be connected and connection 

method.

"2 Selection of External Device" (page 9)

3 Example of Communication Settings

This section shows setting examples for 

communicating between the Display and 

the External Device.

"3 Example of Communication Setting" 
(page 10)

4 Setup Items

This section describes communication 

setup items on the Display.

Set communication settings of the Display 

with GP-Pro Ex or in offline mode.

"4 Setup Items" (page 46)

5 Cable Diagram

This section shows cables and adapters 

for connecting the Display and the 

External Device.

"5 Cable Diagram" (page 54)

Operation
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1 System Configuration

The system configuration in the case when the External Device and the Display are connected is shown.

1.1 Schneider Electric SA External Device.

Series CPU Link I/F
SIO 

Type
Setting Example Cable Diagram

Micro

TSX 37 05 028DR1
TSX 37 08 056DR1
TSX 37 10 128DT1
TSX 37 10 128DR1
TSX 37 10 128DTK1
TSX 37 10 164DTK1
TSX 37 10 028AR1
TSX 37 10 028DR1

TER port on CPU RS232C
Setting Example 1 
(page 10)

Cable Diagram 2 
(page 66)

Accessory box
TSX SCA 50

RS485
 (2wire)

Setting Example 3 
(page 14)

Cable Diagram 3 
(page 67)

TSX 37 21 101
TSX 37 22 101
TSX 37 21 001
TSX 37 22 001

TER port on CPU RS232C
Setting Example 1 
(page 10)

Cable Diagram 2 
(page 66)

Accessory box
TSX SCA 50

RS485
 (2wire)

Setting Example 3 
(page 14)

Cable Diagram 3 
(page 67)

PCMCIA card for RS232C
TSX SCP 111

RS232C
Setting Example 2 
(page 12)

Cable Diagram 4 
(page 80)

PCMCIA card for RS485
TSX SCP 114

RS485
 (2wire)

Setting Example 3 
(page 14)

Cable Diagram 5 
(page 84)

Premium

TSX P57 103M
TSX P57 153M
TSX P57 203M
TSX P57 253M
TSX P57 303M
TSX P57 353M
TSX P57 453M

PCMCIA card for RS232C
TSX SCP 111

RS232C
Setting Example 4 
(page 16)

Cable Diagram 4 
(page 80)

PCMCIA card for RS485
TSX SCP 114

RS485
 (2wire)

Setting Example 5 
(page 18)

Cable Diagram 5 
(page 84)

Twido

TWD LCAA 10DRF
TWD LCAA 16DRF
TWD LCAA 24DRF
TWD LMDA 20DTK
TWD LMDA 
20DUK
TWD LMDA 20DRT
TWD LMDA 40DTK
TWD LMDA 
40DUK


Programming port on CPU RS232C

Setting Example 6 
(page 20)

Cable Diagram 2 
(page 66)

TWD NAC 485T
RS485
 (2wire)

Setting Example 7 
(page 22)

Cable Diagram 1 
(page 54)

Quantum

140 CPU 113 02
140 CPU 113 03
140 CPU 434 12A
140 CPU 534 14A

Modbus port on CPU RS232C
Setting Example 8 
(page 24)

Cable Diagram 6 
(page 96)
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 Connection Configuration

Micro Series

• 1:1 Connection

Premium Series

• 1:1 Connection

Momentum

171 CCS 700 00
171 CCS 700 10
171 CCS 760 00
171 CCC 760 10

Modbus port 1 on CPU RS232C
Setting Example 9 
(page 26)

Cable Diagram 7 
(page 98)

171 CCS 780 00
171 CCC 780 10

Modbus port 1 on CPU RS232C
Setting Example 9 
(page 26)

Cable Diagram 7 
(page 98)

Modbus port 2 on CPU
RS485
 (4wire)

Setting Example 
10 (page 28)

Cable Diagram 8 
(page 100)

171 CCC 980 20
171 CCC 980 30

Modbus port 2 on CPU
RS485
 (4wire)

Setting Example 
10 (page 28)

Cable Diagram 8 
(page 100)

Series CPU Link I/F
SIO 

Type
Setting Example Cable Diagram
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Twido Series

• 1:1 Connection

• 1:n Connection

Quantum Series

• 1:1 Connection

Momentum Series

• 1:1 Connection
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1.2 Yokogawa Electric Corporation External Devices.

 Connection Configuration

FCN/FCJ Series

• 1:1 Connection

• 1:n Connection

Series CPU Link I/F
SIO 

Type
Setting Example Cable Diagram

FCN NFCP100-S00

Serial port on CPU RS232C
Setting Example 
11 (page 30)

Cable Diagram 9 
(page 106)

NFLR111-S00 RS232C
Setting Example 
12 (page 34)

Cable Diagram 
10 (page 108)

NFLR121-S00

RS485
(4 wire)

Setting Example 
13 (page 38)

Cable Diagram 
11 (page 109)

RS485
(2 wire)

Setting Example 
14 (page 42)

Cable Diagram 
12 (page 116)

FCJ NFJT100-S100
Serial port on CONTROL 
UNIT

RS232C
Setting Example 
11 (page 30)

Cable Diagram 9 
(page 106)



MODBUS SIO Master Driver   

GP-Pro EX Device/PLC Connection Manual 7

 IPC COM Port

When connecting IPC with an External Device, the COM port used depends on the series and SIO type. Please 

refer to the IPC manual for details.

Usable port

DIP Switch setting: RS-232C

Series
Usable Port

RS-232C RS-422/485(4 wire) RS-422/485(2 wire)

PS-2000B
COM1*1 , COM2, 
COM3*1, COM4

*1 The RI/5V can be switched. Use the IPC’s switch to change if necessary.

- -

PS-3450A, PS-3451A,
PS3000-BA, PS3001-BD

COM1, COM2*1*2 COM2*1*2 COM2*1*2

PS-3650A (T41 model),
PS-3651A (T41 model)

COM1*1 - -

PS-3650A (T42 model),
PS-3651A (T42 model)

COM1*1*2, COM2 COM1*1*2 COM1*1*2

PS-3700A (Pentium®4-M)
PS-3710A

COM1*1, COM2*1, 
COM3*2 , COM4

*2 Set up the SIO type with the DIP Switch. Please set up as follows according to SIO type to be used.

COM3*2 COM3*2

PS-3711A COM1*1, COM2*2 COM2*2 COM2*2

PS4000*3

*3 When making communication between an External Device and COM port on the Expansion slot,             
only RS-232C is supported. However, ER (DTR/CTS) control cannot be executed because of the             
specification of COM port.
For connection with External Device, use user-created cables and disable Pin Nos. 1, 4, 6 and 9.
Please refer to the IPC manual for details of pin layout.

COM1, COM2 - -

PL3000
COM1*1*2, COM2*1, 
COM3, COM4

COM1*1*2 COM1*1*2

DIP Switch Setting Description

1 OFF*1

*1 When using PS-3450A, PS-3451A, PS3000-BA and PS3001-BD, turn ON the set value.

Reserved (always OFF)

2 OFF
SIO type: RS-232C

3 OFF

4 OFF Output mode of SD (TXD) data: Always output

5 OFF Terminal resistance (220)  insertion to SD (TXD): None

6 OFF Terminal resistance (220)  insertion to RD (RXD): None

7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available

8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available

9 OFF
RS (RTS) Auto control mode: Disabled

10 OFF
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DIP Switch setting: RS-422/485 (4 wire)

DIP Switch setting: RS-422/485 (2 wire)

DIP Switch Setting Description

1 OFF Reserved (always OFF)

2 ON
SIO type: RS-422/485

3 ON

4 OFF Output mode of SD (TXD) data: Always output

5 OFF Terminal resistance (220)  insertion to SD (TXD): None

6 OFF Terminal resistance (220)  insertion to RD (RXD): None

7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available

8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available

9 OFF
RS (RTS) Auto control mode: Disabled

10 OFF

DIP Switch Setting Description

1 OFF Reserved (always OFF)

2 ON
SIO type: RS-422/485

3 ON

4 OFF Output mode of SD (TXD) data: Always output

5 OFF Terminal resistance (220)  insertion to SD (TXD): None

6 OFF Terminal resistance (220)  insertion to RD (RXD): None

7 ON Short-circuit of SDA (TXA) and RDA (RXA): Available

8 ON Short-circuit of SDB (TXB) and RDB (RXB):  Available

9 ON
RS (RTS) Auto control mode: Enabled

10 ON
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2 Selection of External Device

Select the External Device to be connected to the Display.

Setup Items Setup Description

Number of Devices/
PLCs

Enter an integer from 1 to 4 to define the number of Devices/PLCs to connect to the display.

Manufacturer Select the manufacturer of the External Device to connect. Select "Schneider Electric SA".

Series

Select the External Device model (series) and the connection method. Select "MODBUS SIO 
Master".
In System configuration, make sure the External Device you are connecting is supported by 
"MODBUS SIO Master".

"1 System Configuration" (page 3)

Port Select the Display port to connect to the External Device.

Use System Area

Check this option to synchronize the system data area of the Display and the device (memory) 
of the External Device. When synchronized, you can use the External Device’s ladder program 
to switch the display or display the window on the Display.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
This feature can also be set in GP-Pro EX or in the Display's offline mode.

Cf. GP-Pro EX Reference Manual "System Settings [Display Unit] - [System Area] 
Settings Guide"

Cf. Maintenance/Troubleshooting Guide "Main Unit - System Area Settings"
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3 Example of Communication Setting

Examples of communication settings of the Display and the External Device, recommended by Pro-face, are 

shown.

3.1 Setting Example 1

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device

Use the ladder software "PL7 PRO" for communication settings.

Double-click "Hardware Configuration" from "Configuration" in "Application Browser" of "PL7 PRO". Next, 

double-click "Comm" in the "Configuration" dialog box. Perform the settings in the displayed dialog box.

Notes

• Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Setup Description

CHANNEL
CHANNEL 0

MODBUS/JBUS LINK MAST

Slave number 1

Transmission speed 9600bps

Delay between characters 5msec

Data RTU (8 bit)

Stop 1 bit

Parity Even

[Equipment Configuration] tab [Max Query] tab
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3.2 Setting Example 2

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].



MODBUS SIO Master Driver   

GP-Pro EX Device/PLC Connection Manual 13

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device

Use the ladder software "PL7 PRO" for communication settings.

Double-click "Hardware Configuration" from "Configuration" in "Application Browser" of "PL7 PRO". Next, 

double-click "Comm" in the "Configuration" dialog box. Perform the settings in the displayed dialog box.

Notes

Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Setup Description

CHANNEL

CHANNEL 1

TSX SCP 111 RS232 MP PCMCIA CARD

MODBUS/JBUS LINK MAST

Slave number 1

Type Slave

Transmission speed 9600bps

Delay between characters 4msec

Data RTU (8 bit)

Stop 1 bit

Parity Even

[Equipment Configuration] tab [Max Query] tab
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3.3 Setting Example 3

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device

Use the ladder software "PL7 PRO" for communication settings.

Double-click "Hardware Configuration" from "Configuration" in "Application Browser" of "PL7 PRO". Next, 

double-click "Comm" in the "Configuration" dialog box. Perform the settings in the displayed dialog box.

Notes

Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Setup Description

CHANNEL

CHANNEL 1

TSX SCP 114 RS485 MP PCMCIA CARD

MODBUS/JBUS LINK MAST

Slave number 1

Type Slave

Transmission speed 9600bps

Delay between characters 4msec

Data RTU (8 bit)

Stop 1 bit

Parity Even

[Equipment Configuration] tab [Max Query] tab
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3.4 Setting Example 4

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device

Use the ladder software "PL7 PRO" for communication settings.

Double-click "Hardware Configuration" from "Configuration" in "Application Browser" of "PL7 PRO". Next, 

double-click "Comm" in the "Configuration" dialog box. Perform the settings in the displayed dialog box.

Notes

• Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Setup Description

CHANNEL

CHANNEL 1

TSX SCP 111 RS232 MP PCMCIA CARD

MODBUS/JBUS LINK MAST

Type Slave

Slave number 1

Transmission speed 9600bps

Delay between characters 4msec

Data RTU (8 bit)

Stop 1 bit

Parity Even

[Equipment Configuration] tab [Max Query] tab
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3.5 Setting Example 5

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].



MODBUS SIO Master Driver   

GP-Pro EX Device/PLC Connection Manual 19

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device

Use the ladder software "PL7 PRO" for communication settings.

Double-click "Hardware Configuration" from "Configuration" in "Application Browser" of "PL7 PRO". Next, 

double-click "Comm" in the "Configuration" dialog box. Perform the settings in the displayed dialog box.

Notes

Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Setup Description

CHANNEL

CHANNEL 1

TSX SCP 114 RS485 MP PCMCIA CARD

MODBUS/JBUS LINK MAST

Type Slave

Slave number 1

Transmission speed 9600bps

Delay between characters 4msec

Data RTU (8 bit)

Stop 1 bit

Parity Even

[Equipment Configuration] tab [Max Query] tab
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3.6 Setting Example 6

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device

Use the ladder software "TwidoSoft" for communication settings.

Select "Hardware" from "TWDLMDA40DUK" in "Application Browser" of "TwidoSoft", and right-click on 

"Port 1 : Remote Link, 1" to select "Edit Controller Comm Setup...".

Perform the settings in the "Controller Communication Setup" dialog box displayed next.

Notes

Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Setup Description

Protocol
Type Modbus

Address 1

Parameters

Baud Rate 19200

Data Bits 8

Parity None

Stop Bits 1

End of Frame 10

Response Timeout 10 x 100msec

Frame Timeout 4msec

[Equipment Configuration] tab [Max Query] tab
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3.7 Setting Example 7

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device

Use the ladder software "TwidoSoft" for communication settings.

Right-click on "Hardware" from "TWDLMDA40DUK" in "Application Browser" of "TwidoSoft" to select "Add 

Option...". Right-click on "Port 2 : Modbus, 1" added to "Hardware" in "TWDLMDA40DUK" to select "Edit 

Controller Comm Setup...".

Perform the settings in the "Controller Communication Setup" dialog box displayed next.

Notes

Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Setup Description

Protocol
Type Modbus

Address 1

Parameters

Baud Rate 19200

Data Bits 8

Parity None

Stop Bits 1

End of Frame 10

Response Timeout 10 x 100msec

Frame Timeout 10msec

[Equipment Configuration] tab [Max Query] tab
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3.8 Setting Example 8

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device

Use the ladder software "Concept" for communication settings.

After selecting the External Device in Quantum Series in "PLC Selection" of "Concept", select "Modbus Port 

Settings" and perform the settings in the "Modbus Port Settings" dialog box.

Notes

Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Setup Description

Baud 19200

Data Bits 8

Stop Bits 1

Parity Even

Delay(ms) 10

Address 1

Head slot 0

Mode RTU

Protocol RS232

[Equipment Configuration] tab [Max Query] tab
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3.9 Setting Example 9

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device

Use the ladder software "Concept" for communication settings.

After selecting the External Device in Momentum Series in "PLC Selection" of "Concept", select "Modbus Port 

Settings" and perform the settings in the "Modbus Port Settings" dialog box.

Notes

Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Setup Description

Baud 19200

Data Bits 8

Stop Bits 1

Parity Even

Delay(ms) 10

Address 1

Head slot 0

Mode RTU

Protocol RS232

[Equipment Configuration] tab [Max Query] tab
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3.10 Setting Example 10

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device

Use the ladder software "Concept" for communication settings.

After selecting the External Device in Momentum Series in "PLC Selection" of "Concept", select "Modbus Port 

Settings" and perform the settings in the "Modbus Port Settings" dialog box.

Notes

Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Setup Description

Baud 19200

Data Bits 8

Stop Bits 1

Parity Even

Delay(ms) 10

Address 1

Head slot 0

Mode RTU

Protocol RS485

[Equipment Configuration] tab [Max Query] tab
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3.11 Setting Example 11

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device

Use the Web browser and ladder software (Logic Designer) for communication settings.

<Communication Settings for the Serial Port on CPU>

1 Set IP address of the External Device to "192.168.1.1".

2 Connect both the Ethernet ports between a PC and the External Device using the LAN cable. (Connect via HUB.)

3 Start up the Web browser.

4 Enter "http://192.168.1.1/mnt" in the address input box.

5 Enter [User Name] and [Password] in the displayed dialog box to login.

6 Click [Maintenance Menu] to display the [FCX Maintenance Menu] screen.

7 Click [Reboot] to display the [Reboot FCX] screen.

8 Check the [Reboot(Maintenance Mode)] option.

9 Click [OK] to display the [Reboot] screen.

10 Reboot the External Device. Confirm the reboot is complete.

11 Click [Maintenance Homepage] to display the [STARDOM FCX Maintenance Page] screen.

12 Click [OK] to display the [FCX Maintenance Menu] screen.

13 Click [Edit] to display the [Edit System Setting Files] screen.

14 Check the [COM1 Port Setting File] option and click [OK].

• For more details on how to set IP address of the External Device, refer to the online help of the 

dedicated tool for the FCN/FCJ basic settings (Resource Configurator).

[Equipment Configuration] tab [Max Query] tab
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15 Set each item as follows:

16 Click [OK] to display the [Edit System Setting Files(RESULT)] screen.

17 Click [Maintenance Menu] to display the [FCX Maintenance Menu] screen.

18 Click [Reboot] to display the [Reboot FCX] screen.

19 Check the [Reboot(Online Mode)] option and click [OK].

The External Device is rebooted.

<Control Logic Download Procedures>

1 Start up the ladder software.

2 Create the control logic in order to start the MODBUS communication (RTU mode) slave function. For the 

example of control logic, refer to "Control Logic Example".

"  Control Logic Example" (page 33)

3 Double-click ['COM1'] next to [PORT] to display the [Variable Properties] dialog box.

4 Enter the connecting port name in [Name], and click [OK].

5 Double-click [UNIT#1] next to [STATION] to display the [Variable Properties] dialog box.

6 Enter the connecting station name in [Name], and click [OK].

7 Select [Rebuild Project] from the [Build] menu.

8 Double-click [Target Setting] in the project tree window to display the [Target] dialog box.

9 Enter "192.168.1.1" in [Host Name/IP Address].

10 Click [OK].

11 Download the communication settings to the External Device.

12 Reboot the External Device.

Setup Items Setup Description

Baudrate 19200

DataBitLength 8

StopBitLength 1

Parity EVEN
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Control Logic Example

To connect the Display to the External Device, the control logic is required.

The control logic example is shown below.

SD_CMDBSM_BS_OPEN1
SD_CMDBSM_BS_OPEN

TRUE          REQ                      VALID          RTU_VALID1

'COM1'          PORT                  ERROR          RTU_ERROR1

.          OPTION             STATUS          RTU_STATUS1

UNIT#1          STATION       POSITION          RTU_POSITION1

10.0          TOUT_VAL

' YOKOGAWA '          VENDOR

' STARDOM '          PRODUCT

COIL          COIL                       COIL          COIL

DSCI          DSCI                      DSCI          DSCI

IREG          IREG                      IREG          IREG

HREG        HREG                     HREG        HREG

ESTS         ESTS                      ESTS         ESTS

RTU_COMERR1         COMERR         COMERR         RTU_COMERR1

' R1.80.01 '          REVISION

FALSE          UNIT_CHARTM
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3.12 Setting Example 12

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device

Use the dedicated tool for basic settings (Resource Configurator) and ladder software (Logic Designer) for 

communication settings.

<Communication Settings for the Communication Module>

1 Set IP address of the External Device to "192.168.1.1".

2 Start up the dedicated tool for the basic settings.

3 From the [File] menu, select [Connection] to display the [Connect] dialog box.

4 Enter "192.168.1.1" in [Host].

5 Enter [User Name] and [Password] to login.

6 Select the link I/F to use from the [Controller Configuration] tree view.

7 Enter the port name in [Port Name].

8 Select [Port1] from the link I/F to use the [Controller Configuration] tree view.

• For more details on how to set IP address of the External Device, refer to the online help of the 

dedicated tool for the FCN/FCJ basic settings.

[Equipment Configuration] tab [Max Query] tab
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9 Set specifications as follows:

10 Download the communication settings to the External Device.

11 Reboot the External Device.

<Control Logic Download Procedures>

1 Start up the ladder software.

2 Create the control logic in order to start the MODBUS communication (RTU mode) slave function. For the 

example of control logic, refer to "Control Logic Example".

"  Control Logic Example" (page 37)

3 Double-click ['COM1'] next to [PORT] to display the [Variable Properties] dialog box.

4 Enter the connecting port name in [Name], and click [OK].

5 Double-click [UNIT#1] next to [STATION] to display the [Variable Properties] dialog box.

6 Enter the connecting station name in [Name], and click [OK].

7 Select [Rebuild Project] from the [Build] menu.

8 Double-click [Target Setting] in the project tree window to display the [Target] dialog box.

9 Enter "192.168.1.1" in [Host Name/IP Address].

10 Click [OK].

11 Download the communication settings to the External Device.

12 Reboot the External Device.

Specifications Setting

Wiring Method -

Duplex Operation Full-duplex

Baud Rate 19200

Data Bits 8

Parity Setting EVEN

Stop Bits 1

Send Signal Check NONE

Receive Flow Control NONE

API Error Detection YES



MODBUS SIO Master Driver   

GP-Pro EX Device/PLC Connection Manual 37

Control Logic Example

To connect the Display to the External Device, the control logic is required.

The control logic example is shown below.

SD_CMDBSM_BS_OPEN1
SD_CMDBSM_BS_OPEN

TRUE          REQ                      VALID          RTU_VALID1

'COM1'          PORT                  ERROR          RTU_ERROR1

.          OPTION             STATUS          RTU_STATUS1

UNIT#1          STATION       POSITION          RTU_POSITION1

10.0          TOUT_VAL

' YOKOGAWA '          VENDOR

' STARDOM '          PRODUCT

COIL          COIL                       COIL          COIL

DSCI          DSCI                      DSCI          DSCI

IREG          IREG                      IREG          IREG

HREG        HREG                     HREG        HREG

ESTS         ESTS                      ESTS         ESTS

RTU_COMERR1         COMERR         COMERR         RTU_COMERR1

' R1.80.01 '          REVISION

FALSE          UNIT_CHARTM
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3.13 Setting Example 13

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device

Use the dedicated tool for basic settings (Resource Configurator) and ladder software (Logic Designer) for 

communication settings.

<Communication Settings for the Communication Module>

1 Set IP address of the External Device to "192.168.1.1".

2 Start up the dedicated tool for the basic settings.

3 From the [File] menu, select [Connection] to display the [Connect] dialog box.

4 Enter "192.168.1.1" in [Host].

5 Enter [User Name] and [Password] to login.

6 Select the link I/F to use from the [Controller Configuration] tree view.

7 Enter the port name in [Port Name].

8 Select [Port1] from the link I/F to use the [Controller Configuration] tree view.

• For more details on how to set IP address of the External Device, refer to the online help of the 

dedicated tool for the FCN/FCJ basic settings.

[Equipment Configuration] tab [Max Query] tab
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9 Set specifications as follows:

10 Download the communication settings to the External Device.

11 Reboot the External Device.

<Control Logic Download Procedures>

1 Start up the ladder software.

2 Create the control logic in order to start the MODBUS communication (RTU mode) slave function. For the 

example of control logic, refer to "Control Logic Example".

"  Control Logic Example" (page 41)

3 Double-click ['COM1'] next to [PORT] to display the [Variable Properties] dialog box.

4 Enter the connecting port name in [Name], and click [OK].

5 Double-click [UNIT#1] next to [STATION] to display the [Variable Properties] dialog box.

6 Enter the connecting station name in [Name], and click [OK].

7 Select [Rebuild Project] from the [Build] menu.

8 Double-click [Target Setting] in the project tree window to display the [Target] dialog box.

9 Enter "192.168.1.1" in [Host Name/IP Address].

10 Click [OK].

11 Download the communication settings to the External Device.

12 Reboot the External Device.

Specifications Setting

Wiring Method -

Duplex Operation Full-duplex

Baud Rate 19200

Data Bits 8

Parity Setting EVEN

Stop Bits 1

Send Signal Check NONE

Receive Flow Control NONE

API Error Detection YES
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Control Logic Example

To connect the Display to the External Device, the control logic is required.

The control logic example is shown below.

SD_CMDBSM_BS_OPEN1
SD_CMDBSM_BS_OPEN

TRUE          REQ                      VALID          RTU_VALID1

'COM1'          PORT                  ERROR          RTU_ERROR1

.          OPTION             STATUS          RTU_STATUS1

UNIT#1          STATION       POSITION          RTU_POSITION1

10.0          TOUT_VAL

' YOKOGAWA '          VENDOR

' STARDOM '          PRODUCT

COIL          COIL                       COIL          COIL

DSCI          DSCI                      DSCI          DSCI

IREG          IREG                      IREG          IREG

HREG        HREG                     HREG        HREG

ESTS         ESTS                      ESTS         ESTS

RTU_COMERR1         COMERR         COMERR         RTU_COMERR1

' R1.80.01 '          REVISION

FALSE          UNIT_CHARTM
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3.14 Setting Example 14

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device

Use the dedicated tool for basic settings (Resource Configurator) and ladder software (Logic Designer) for 

communication settings.

<Communication Settings for the Communication Module>

1 Set IP address of the External Device to "192.168.1.1".

2 Start up the dedicated tool for the basic settings.

3 From the [File] menu, select [Connection] to display the [Connect] dialog box.

4 Enter "192.168.1.1" in [Host].

5 Enter [User Name] and [Password] to login.

6 Select the link I/F to use from the [Controller Configuration] tree view.

7 Enter the port name in [Port Name].

8 Select [Port1] from the link I/F to use the [Controller Configuration] tree view.

• For more details on how to set IP address of the External Device, refer to the online help of the 

dedicated tool for the FCN/FCJ basic settings.

[Equipment Configuration] tab [Max Query] tab
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9 Set specifications as follows:

10 Download the communication settings to the External Device.

11 Reboot the External Device.

<Control Logic Download Procedures>

1 Start up the ladder software.

2 Create the control logic in order to start the MODBUS communication (RTU mode) slave function. For the 

example of control logic, refer to "Control Logic Example".

"  Control Logic Example" (page 45)

3 Double-click ['COM1'] next to [PORT] to display the [Variable Properties] dialog box.

4 Enter the connecting port name in [Name], and click [OK].

5 Double-click [UNIT#1] next to [STATION] to display the [Variable Properties] dialog box.

6 Enter the connecting station name in [Name], and click [OK].

7 Select [Rebuild Project] from the [Build] menu.

8 Double-click [Target Setting] in the project tree window to display the [Target] dialog box.

9 Enter "192.168.1.1" in [Host Name/IP Address].

10 Click [OK].

11 Download the communication settings to the External Device.

12 Reboot the External Device.

Specifications Setting

Wiring Method -

Duplex Operation Full-duplex

Baud Rate 19200

Data Bits 8

Parity Setting EVEN

Stop Bits 1

Send Signal Check NONE

Receive Flow Control NONE

API Error Detection YES
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Control Logic Example

To connect the Display to the External Device, the control logic is required.

The control logic example is shown below.

SD_CMDBSM_BS_OPEN1
SD_CMDBSM_BS_OPEN

TRUE          REQ                      VALID          RTU_VALID1

'COM1'          PORT                  ERROR          RTU_ERROR1

.          OPTION             STATUS          RTU_STATUS1

UNIT#1          STATION       POSITION          RTU_POSITION1

10.0          TOUT_VAL

' YOKOGAWA '          VENDOR

' STARDOM '          PRODUCT

COIL          COIL                       COIL          COIL

DSCI          DSCI                      DSCI          DSCI

IREG          IREG                      IREG          IREG

HREG        HREG                     HREG        HREG

ESTS         ESTS                      ESTS         ESTS

RTU_COMERR1         COMERR         COMERR         RTU_COMERR1

' R1.80.01 '          REVISION

FALSE          UNIT_CHARTM
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4 Setup Items

Set communication settings of the Display with GP-Pro EX or in offline mode of the Display.

The setting of each parameter must be identical to that of External Device.

"3 Example of Communication Setting" (page 10)

4.1 Setup Items in GP-Pro EX

 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC]. 

Setup Items Setup Description

SIO Type Select the SIO type to communicate with the External Device.

Speed Select speed between the External Device and the Display.

Data Length Select data length.

Parity Select how to check parity.

Stop Bit Select stop bit length.

Flow Control
Select the communication control method to prevent overflow of transmission and 
reception data.

Timeout
Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the 
response from the External Device.

Retry
In case of no response from the External Device, use an integer from 0 to 255 to enter how 
many times the Display retransmits the command.
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Wait To Send

Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving 
packets to transmitting next commands.
When the check box of the default value is checked, the Wait To Send value automatically 
changes in the formula below by changing each value for Speed/Data Length/Parity/Stop 
Bit.

Wait To Send (ms) =

Value for the parity setting is shown below.
 No Parity = 0
 Parity Even = 1
 Parity Odd = 1

• After changing the Wait To Send value for the project, of which [Default Value] is 
checked, in the offline mode, the Wait To Send value will be recalculated when the 
project is received and communication settings are displayed.

RI/VCC
You can switch RI/VCC of the 9th pin when you select RS232C for SIO type.
It is necessary to change RI/5V by changeover switch of IPC when connect with IPC. 
Please refer to the manual of the IPC for more detail.

• Refer to the GP-Pro EX Reference Manual for Indirect Device.

Cf. GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect 
Device)"

Setup Items Setup Description

3500 x (1 + Data Length + Stop Bit + Parity)
Speed (bps)
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

Setup Items Setup Description

Slave Equipment Address
Use an integer from 1 to 247 to enter the slave equipment address of the 
External Device.

Bit manipulation (set / reset) to 
Holding Resister From "Clear" or "Do not clear", select treatment of the rest of the bits in the 

same word when the bit manipulation to Holding Register is performed.Rest of the bits in 
this word

IEC61131 Syntax
Check this item when you use the IEC61131 syntax for variables. In case that 
you check on, select Address Mode, [0-based] or [1-based].

Double Word word order
Select the order of storing double word data from "Low word first" or "High 
word first".

Low Security Level Put a check when lowering the format check level.

[Equipment Configuration] tab
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Setup Items Setup Description

Coil Set the number of max data for device [coil] which can be read for one 
communication, using 16 to 2000 bits.

• When [Single Bit manipulation to Coil/Discrete Input] is checked, set the 
data maximum number from 1 to 2000.

Read

Coil Set the number of max data for device [coil] which can be written for one 
communication, using 1 to 800 bits.Write

Discrete Input Set the number of max data for device [discrete input] which can be read for 
one communication, using 16 to 2000 bits.

• When [Single Bit manipulation to Coil/Discrete Input] is checked, set the 
data maximum number from 1 to 2000.

Read

Input Register Set the number of max data for device [input register] which can be read for 
one communication, using 1 to 125 words.Read

Holding Register Set the number of max data for device [holding register] which can be read 
for one communication, using 1 to 125 words.Read

Holding Register Set the number of max data for device [holding register] which can be written 
for one communication, using 1 to 100 words.Write

Single Bit manipulation to Coil/
Discrete Input

Put a check when writing in or reading out coil or discreet input in bits.

[Max Query] tab
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4.2 Setup Items in Offline Mode

Communication Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings] in offline mode. Touch the 

External Device you want to set from the displayed list.

• Refer to the Maintenance/Troubleshooting guide for information on how to enter offline mode or 

about the operation.

Cf. Maintenance/Troubleshooting Guide "Offline Mode"

• The number of the setup items to be displayed for 1 page in the offline mode depends on the 

Display in use. Please refer to the Reference manual for details.

Setup Items Setup Description

SIO Type

Select the SIO type to communicate with the External Device.

To make the communication settings correctly, confirm the serial interface specifications of 
Display unit for [SIO Type].
We cannot guarantee the operation if a communication type that the serial interface does 
not support is specified.
For details concerning the serial interface specifications, refer to the manual for Display 
unit.

Speed Select speed between the External Device and the Display.

Data Length Select data length.

Parity Select how to check parity.

Stop Bit Select stop bit length.

Flow Control
Select the communication control method to prevent overflow of transmission and 
reception data.
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Device Setting

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device 

you want to set from the displayed list, and touch [Device].

.

Timeout
Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the 
response from the External Device.

Retry
In case of no response from the External Device, use an integer from 0 to 255 to enter how 
many times the Display retransmits the command.

Wait To Send
Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving 
packets to transmitting next commands.

Setup Items Setup Description

Device/PLC Name
Select the External Device for device setting. Device name is a title of 
External Device set with GP-Pro EX. (Initial value [PLC1])

Slave Address
Use an integer from 1 to 247 to enter the slave equipment address of the 
External Device.

Bit manipulation to HR

From "Rest of bits in word are cleared" or "Rest of bits in word are not 
cleared", select treatment of the rest of the bits in the same word when the bit 
manipulation to Holding Register is performed. (Not available to set in 
offline mode.)

IEC61131 Syntax
Displays the usage status of the currently set IEC61131 syntax in ON/OFF. 
(Not available in offline mode.)

Double Word word order
Displays the currently set order of storing double word data from "Low word 
first" or "High word first". (Not available to set in offline mode.)

Low Security Level
When an format check level is lowered, ON/OFF is displayed. When the 
level is lowered, ON is displayed. (Not available to set in offline mode.)

Setup Items Setup Description
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Coil Displays the number of max data for device [coil] which can be read for one 
communication. (Not available to set in offline mode.)Read

Coil Displays the number of max data for device [coil] which can be written for 
one communication. (Not available to set in offline mode.)Write

Discrete Input Displays the number of max data for device [discrete input] which can be 
read for one communication. (Not available to set in offline mode.)Read

Input Register Set the number of max data for device [input register] which can be read for 
one communication, using 1 to 125 words.Read

Holding Register Set the number of max data for device [holding register] which can be read 
for one communication, using 1 to 125 words.Read

Holding Register Set the number of max data for device [holding register] which can be written 
for one communication, using 1 to 100 words.Write

Single Bit manipulation
ON/OFF display shows whether the coil or discreet input is written or read 
out in bits. If ON is displayed, writing or reading can be executed in bits. (Not 
available to set in offline mode.)

Setup Items Setup Description
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Option

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device 

you want to set from the displayed list, and touch [Option].

Setup Items Setup Description

RI/VCC
You can switch RI/VCC of the 9th pin when you select RS232C for SIO type.
It is necessary to change RI/5V by changeover switch of IPC when connect with IPC. 
Please refer to the manual of the IPC for more detail.

• GP-4100 series, GP-4*01TM and LT-4*01TM do not have the [Option] setting in the offline 

mode.
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5 Cable Diagram

The following cable diagrams may be different from cable diagrams recommended by External Device 

Manufacturer.

Please be assured there is no operational problem in applying the cable diagram shown in this manual.

• The FG pin of the External Device body must be grounded according to your country’s applicable standard. 

Refer to your External Device manual for details.

• SG and FG are connected inside the Display. When connecting the External Device to SG, design your system 

to avoid short-circuit loops.

• Connect an isolation unit if the communication is not stable due to noise or other factors.

5.1 Cable Diagram 1

Display

(Connection Port)
Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
ST*2 (COM2)
LT3000 (COM1)

1A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 200m or 
less.

1B User-created cable

GP3000*3 (COM2)

1C

Online Adapter by Pro-face
CA4-ADPONL-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 200m or 
less.

1D

Online Adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

IPC*4 1E

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 200m or 
less.

1F User-created cable

GP-4106  (COM1)
1G User-created cable

The cable length 
must be 200m or 
less.

GP-4107  (COM1)
GP-4*03T*5 (COM2)
GP-4203T (COM1)

1H User-created cable
The cable length 
must be 200m or 
less.
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GP4000*6 (COM2)
GP-4201T (COM1)

1I

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1

*7

+
User-created cable

The cable length 
must be 200m or 
less.

1B User-created cable

LT-4*01TM (COM1)
1J

RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81

*1  All GP3000 models except AGP-3302B

*2  All ST models except AST-3211A and AST-3302B

*3 All GP3000 models except GP-3200 series and AGP-3302B

*4 Only the COM port which can communicate by RS-422/485 (2 wire) can be used.

 IPC COM Port (page 7)

*5 Except GP-4203T

*6 All GP4000 models except GP-4100 series, GP-4*01TM, GP-4201T and GP-4*03T

*7 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block             
Conversion Adapter, refer to Cable Diagram 1A.

Display

(Connection Port)
Cable Notes
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1A)

• 1:1 Connection

• 1:n Connection

Legend Name Notes

(1)
COM Port Conversion Adapter by Pro-face

CA3-ADPCOM-01

(2)
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01

• The cable length must be 200m or less.
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1B)

• 1:1 Connection

• 1:n Connection

• The cable length must be 200m or less.
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1C)

• 1:1 Connection

• 1:n Connection

Legend Name Notes

(1)
Online Adapter by Pro-face

CA4-ADPONL-01

(2)
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01

• The cable length must be 200m or less.
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1D)

• 1:1 Connection

• 1:n Connection

Legend Name Notes

(1)
Online Adapter by Pro-face

CA4-ADPONL-01

• The cable length must be 200m or less.
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1E)

• 1:1 Connection

• 1:n Connection

Legend Name Notes

(1)
COM Port Conversion Adapter by Pro-face

CA3-ADPCOM-01

(2)
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01

• The cable length must be 200m or less.
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1F)

• 1:1 Connection

• 1:n Connection

• The cable length must be 200m or less.
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1G)

• 1:1 Connection

• 1:n Connection

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.  

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

• The cable length must be 200m or less.
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1H)

• 1:1 Connection

• 1:n Connection

• The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS 

connector. Do not use it for other devices.

• In COM on the GP-4107, the SG and FG terminals are isolated.

• The cable length must be 200m or less.
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1I)

• 1:1 Connection

• 1:n Connection

Legend Name Notes

(1)
RS-422 Terminal Block Conversion Adapter by Pro-face

PFXZCBADTM1

• The cable length must be 200m or less.
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1J)

• 1:1 Connection

• 1:n Connection

Legend Name Notes

(1)
RJ45 RS-485 Cable (5m) by Pro-face

PFXZLMCBRJR81

• The cable length must be 200m or less.
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5.2 Cable Diagram 2

2A)

2B)

Display

(Connection Port)
Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
ST  (COM1)
LT3000 (COM1)
IPC*2

PC/AT

*1 All GP4000 models except GP-4100 series and GP-4203T

*2 Only the COM port which can communicate by RS-232C can be used.

 IPC COM Port (page 7)

2A
Cable by Schneider Electric Industries

TSX PCX 1031 (2.5m)*3

*3 Set the rotary switch to "3 (OTHER DIRECT)".

GP-4105  (COM1) 2B

User-created cable
+

Cable by Schneider Electric Industries
TSX PCX 1031 (2.5m)*2

Legend Name Notes

(1)
Cable by Schneider Electric Industries

TSX PCX 1031 (2.5m)*1

*1 Set the rotary switch to "3 (OTHER DIRECT)".

Legend Name Notes

(1)
Cable by Schneider Electric Industries

TSX PCX 1031 (2.5m)*1

*1 Set the rotary switch to "3 (OTHER DIRECT)".
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5.3 Cable Diagram 3

Display

(Connection Port)
Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
ST*2 (COM2)
LT3000 (COM1)

3A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
+

Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must 
be 10m or less.*3

3B

User-created cable
+

Accessory box by Schneider Electric Industries
TSX SCA 50

GP3000*4 (COM2)

3C

Online Adapter by Pro-face
CA4-ADPONL-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
+

Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must 
be 10m or less.*3

3D

Online Adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

+
Accessory box by Schneider Electric Industries

TSX SCA 50

IPC*5

3E

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
+

Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must 
be 10m or less.*3

3F

User-created cable
+

Accessory box by Schneider Electric Industries
TSX SCA 50
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GP-4106  (COM1)
3G

User-created cable
+

Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must 
be 10m or less.*3

GP-4107  (COM1)
GP-4*03T*6 (COM2)
GP-4203T (COM1)

3H

User-created cable
+

Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must 
be 10m or less.*3

GP4000*7 (COM2)
GP-4201T (COM1)

3I

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1

*8

+
User-created cable

+
Accessory box by Schneider Electric Industries

TSX SCA 50

The cable length must 
be 10m or less.*3

3B

User-created cable
+

Accessory box by Schneider Electric Industries
TSX SCA 50

LT-4*01TM (COM1)
3J

RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81

+
Accessory box by Schneider Electric Industries

TSX SCA 50

*1  All GP3000 models except AGP-3302B

*2  All ST models except AST-3211A and AST-3302B

*3 Max length between the Display and the "Accessory Box connected to Display". Total cable length between 
accessory boxes must be 1000m or less.

*4 All GP3000 models except GP-3200 series and AGP-3302B

*5 Only the COM port which can communicate by RS-422/485 (2 wire) can be used.

 IPC COM Port (page 7)

*6 Except GP-4203T

*7 All GP4000 models except GP-4100 series, GP-4*01TM, GP-4201T and GP-4*03T

*8 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block             
Conversion Adapter, refer to Cable Diagram 3A.

Display

(Connection Port)
Cable Notes
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3A)

• 1:1 Connection

• 1:n Connection

Legend Name Notes

(1)
COM Port Conversion Adapter by Pro-face

CA3-ADPCOM-01

(2)
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01

• The cable length must be 10m or less.*1

*1 Max length between the Display and the "Accessory Box connected to Display". Total cable length 
between accessory boxes must be 1000m or less.
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3B)

• 1:1 Connection

• 1:n Connection

• The cable length must be 10m or less.*1

*1 Max length between the Display and the "Accessory Box connected to Display". Total cable length 
between accessory boxes must be 1000m or less.
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3C)

• 1:1 Connection

• 1:n Connection

Legend Name Notes

(1)

Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01

Online Adapter by Pro-face
CA4-ADPONL-01

(2)
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01

• The cable length must be 10m or less.*1

*1 Max length between the Display and the "Accessory Box connected to Display". Total cable length 
between accessory boxes must be 1000m or less.
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3D)

• 1:1 Connection

• 1:n Connection

Legend Name Notes

(1)
Online Adapter by Pro-face

CA4-ADPONL-01

• The cable length must be 10m or less.*1

*1 Max length between the Display and the "Accessory Box connected to Display". Total cable length 
between accessory boxes must be 1000m or less.
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3E)

• 1:1 Connection

• 1:n Connection

Legend Name Notes

(1)
COM Port Conversion Adapter by Pro-face

CA3-ADPCOM-01

(2)
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01

• The cable length must be 10m or less.*1

*1 Max length between the Display and the "Accessory Box connected to Display". Total cable length 
between accessory boxes must be 1000m or less.
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3F)

• 1:1 Connection

• 1:n Connection

• The cable length must be 10m or less.*1

*1 Max length between the Display and the "Accessory Box connected to Display". Total cable length 
between accessory boxes must be 1000m or less.
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3G)

• 1:1 Connection

• 1:n Connection

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.    

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON
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• The cable length must be 10m or less.*1

*1 Max length between the Display and the "Accessory Box connected to Display". Total cable length 
between accessory boxes must be 1000m or less.
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3H) 

• 1:1 Connection

• 1:n Connection

• The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS 

connector. Do not use it for other devices.

• In COM on the GP-4107, the SG and FG terminals are isolated.

• The cable length must be 10m or less.*1

*1 Max length between the Display and the "Accessory Box connected to Display". Total cable length 
between accessory boxes must be 1000m or less.
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3I)

• 1:1 Connection

• 1:n Connection

Legend Name Notes

(1)
RS-422 Terminal Block Conversion Adapter by Pro-face

PFXZCBADTM1

• The cable length must be 10m or less.*1

*1 Max length between the Display and the "Accessory Box connected to Display". Total cable length 
between accessory boxes must be 1000m or less.
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3J)

• 1:1 Connection

• 1:n Connection

Legend Name Notes

(1)
RJ45 RS-485 Cable (5m) by Pro-face

PFXZLMCBRJR81

• The cable length must be 10m or less.*1

*1 Max length between the Display and the "Accessory Box connected to Display". Total cable length 
between accessory boxes must be 1000m or less.
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5.4 Cable Diagram 4

Display

(Connection Port)
Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
ST  (COM1)
LT3000 (COM1)
IPC*2

PC/AT

*1 All GP4000 models except GP-4100 series and GP-4203T

*2 Only the COM port which can communicate by RS-232C can be used.

 IPC COM Port (page 7)

4A

User-created cable
+

RS 232 D tap link cable by Schneider Electric
TSX SCP CC 1030 (3m)

+
PCMCIA card for RS232C by Schneider Electric

TSX SCP 111

The cable length must 
be 15m or less.*3

*3 Total length for TSX SCP CC 1030 and User-created cable.

GP-4105  (COM1) 4B

User-created cable
+

RS 232 D tap link cable by Schneider Electric
TSX SCP CC 1030 (3m)

+
PCMCIA card for RS232C by Schneider Electric

TSX SCP 111

The cable length must 
be 15m or less.*3

LT-4*01TM (COM1)
4C

RJ45 RS-232C Cable (5m) by Pro-face
PFXZLMCBRJR21

+
RS 232 D tap link cable by Schneider Electric

TSX SCP CC 1030 (3m)
+

PCMCIA card for RS232C by Schneider Electric
TSX SCP 111
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4A)

Legend Name Notes

(1)
RS 232 D tap link cable by Schneider Electric

TSX SCP CC 1030 (3m)

(2)
PCMCIA card for RS232C by Schneider Electric

TSX SCP 111

• The cable length must be 15m or less. *1

*1 Total length for TSX SCP CC 1030 and User-created cable.
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4B)

Legend Name Notes

(1)
RS 232 D tap link cable by Schneider Electric

TSX SCP CC 1030 (3m)

(2)
PCMCIA card for RS232C by Schneider Electric

TSX SCP 111

• The cable length must be 15m or less. *1

*1 Total length for TSX SCP CC 1030 and User-created cable.
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4C)

Legend Name Notes

(1)
RJ45 RS-232C Cable (5m) by Pro-face

PFXZLMCBRJR21

(2)
RS 232 D tap link cable by Schneider Electric

TSX SCP CC 1030 (3m)

(3)
PCMCIA card for RS232C by Schneider Electric

TSX SCP 111

• The cable length must be 15m or less. *1

*1 Total length for TSX SCP CC 1030 and User-created cable.
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5.5 Cable Diagram 5

Display

(Connection Port)
Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
ST*2 (COM2)
LT3000 (COM1)

5A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
+

Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)

+
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114

5B

User-created cable
+

Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)

+
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114

GP3000*3 (COM2)

5C

Online Adapter by Pro-face
CA4-ADPONL-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
+

Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)

+
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114

5D

Online Adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

+
Uni-Telway cable by Schneider Electric Industries

TSX SCP CU 4030 (3m)
+

PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114
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IPC*4

5E

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
+

Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)

+
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114

5F

User-created cable
+

Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)

+
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114

GP-4106  (COM1)
5G

User-created cable
+

Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)

+
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114

GP-4107  (COM1)
GP-4*03T*5 (COM2)
GP-4203T (COM1)

5H

User-created cable
+

Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)

+
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114

GP4000*6 (COM2)
GP-4201T (COM1)

5I

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1

*7

+
User-created cable

+
Uni-Telway cable by Schneider Electric Industries

TSX SCP CU 4030 (3m)
+

PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114

5B

User-created cable
+

Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)

+
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114

Display

(Connection Port)
Cable Notes
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5A)

LT-4*01TM (COM1)
5J

RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81

+
Uni-Telway cable by Schneider Electric Industries

TSX SCP CU 4030 (3m)
+

PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114

*1  All GP3000 models except AGP-3302B

*2  All ST models except AST-3211A and AST-3302B

*3 All GP3000 models except GP-3200 series and AGP-3302B

*4 Only the COM port which can communicate by RS-422/485 (2 wire) can be used.

 IPC COM Port (page 7)

*5 Except GP-4203T

*6 All GP4000 models except GP-4100 series, GP-4*01TM, GP-4201T and GP-4*03T

*7 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block             
Conversion Adapter, refer to Cable Diagram 5A.

Legend Name Notes

(1)
COM Port Conversion Adapter by Pro-face

CA3-ADPCOM-01

(2)
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01

(3)
Uni-Telway cable by Schneider Electric Industries

TSX SCP CU 4030 (3m)

(4)
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114

Display

(Connection Port)
Cable Notes
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5B)

Legend Name Notes

(1)
Uni-Telway cable by Schneider Electric Industries

TSX SCP CU 4030 (3m)

(2)
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114
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5C)

Legend Name Notes

(1)
Online Adapter by Pro-face

CA4-ADPONL-01

(2)
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01

(3)
Uni-Telway cable by Schneider Electric Industries

TSX SCP CU 4030 (3m)

(4)
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114
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5D)

Legend Name Notes

(1)
Online Adapter by Pro-face

CA4-ADPONL-01

(2)
Uni-Telway cable by Schneider Electric Industries

TSX SCP CU 4030 (3m)

(3)
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114
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5E)

Legend Name Notes

(1)
COM Port Conversion Adapter by Pro-face

CA3-ADPCOM-01

(2)

Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01

Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01

(3)
Uni-Telway cable by Schneider Electric Industries

TSX SCP CU 4030 (3m)

(4)
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114
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5F)

Legend Name Notes

(1)
Uni-Telway cable by Schneider Electric Industries

TSX SCP CU 4030 (3m)

(2)
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114
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5G)

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below. 

Legend Name Notes

(1)
Uni-Telway cable by Schneider Electric Industries

TSX SCP CU 4030 (3m)

(2)
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON
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5H)

Legend Name Notes

(1)
Uni-Telway cable by Schneider Electric Industries

TSX SCP CU 4030 (3m)

(2)
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114

• The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS 

connector. Do not use it for other devices.

• In COM on the GP-4107, the SG and FG terminals are isolated.
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5I)

Legend Name Notes

(1)
RS-422 Terminal Block Conversion Adapter by Pro-face

PFXZCBADTM1
*1

*1 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block             
Conversion Adapter, refer to Cable Diagram 5A.

(2)
Uni-Telway cable by Schneider Electric Industries

TSX SCP CU 4030 (3m)

(3)
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114
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5J)

Legend Name Notes

(1)
RJ45 RS-485 Cable (5m) by Pro-face

PFXZLMCBRJR81

(2)
Uni-Telway cable by Schneider Electric Industries

TSX SCP CU 4030 (3m)

(3)
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114
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5.6 Cable Diagram 6

6A)

Display

(Connection Port)
Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
ST  (COM1)
LT3000 (COM1)
IPC*2

PC/AT

*1 All GP4000 models except GP-4100 series and GP-4203T

*2 Only the COM port which can communicate by RS-232C can be used.

 IPC COM Port (page 7)

6A User-created cable
The cable length must be 
15m or less.

GP-4105  (COM1) 6B User-created cable
The cable length must be 
15m or less.

LT-4*01TM (COM1)
6C

RJ45 RS-232C Cable (5m) by Pro-face
PFXZLMCBRJR21

• The cable length must be 15m or less.
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6B)

6C)

• The cable length must be 15m or less.

Legend Name Notes

(1)
RJ45 RS-232C Cable (5m) by Pro-face

PFXZLMCBRJR21

• The cable length must be 15m or less.
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5.7 Cable Diagram 7

7A)

Display

(Connection Port)
Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
ST  (COM1)
LT3000 (COM1)
IPC*2

PC/AT

*1 All GP4000 models except GP-4100 series and GP-4203T

*2 Only the COM port which can communicate by RS-232C can be used.

 IPC COM Port (page 7)

7A

D-Shell adapter by Schneider Electric
 110 XCA 203 00

+
RS232 communication cable RJ45 to RJ45 by Schneider Electric

110 XCA 282 01(1m), 110 XCA 282 02(3m) or 110 XCA 282 03(6m)

The cable 
length must 
be 9.5m or 
less.

GP-4105  (COM1) 7B

User-created cable
+

D-Shell adapter by Schneider Electric
 110 XCA 203 00

+
RS232 communication cable RJ45 to RJ45 by Schneider Electric

110 XCA 282 01(1m), 110 XCA 282 02(3m) or 110 XCA 282 03(6m)

The cable 
length must 
be 9.5m or 
less.

Legend Name Notes

(1)
D-Shell adapter by Schneider Electric

 110 XCA 203 00

(2)
RS232 communication cable RJ45 to RJ45 by Schneider Electric

110 XCA 282 01(1m), 110 XCA 282 02(3m) or 110 XCA 282 03(6m)

• The cable length must be 9.5m or less.
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7B)

Legend Name Notes

(1)
D-Shell adapter by Schneider Electric

 110 XCA 203 00

(2)
RS232 communication cable RJ45 to RJ45 by Schneider Electric

110 XCA 282 01(1m), 110 XCA 282 02(3m) or 110 XCA 282 03(6m)

• The cable length must be 9.5m or less.
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5.8 Cable Diagram 8

Display

(Connection Port)
Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
ST*2 (COM2)
LT3000 (COM1)
IPC*3

*1  All GP3000 models except AGP-3302B

*2  All ST models except AST-3211A and AST-3302B

*3 Only the COM port which can communicate by RS-422/485 (4 wire) can be used.

 IPC COM Port (page 7)

8A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 500m or less.

8B User-created cable

GP3000*4 (COM2)

*4 All GP3000 models except GP-3200 series and AGP-3302B

8C

Online Adapter by Pro-face
CA4-ADPONL-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 500m or less.

8D

Online Adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

GP-4106  (COM1)
8E User-created cable

The cable length 
must be 500m or less.

GP4000*5 (COM2)
GP-4201T (COM1)

*5 All GP4000 models except GP-4100 series, GP-4*01TM, GP-4201T and GP-4*03T

8F

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1

*6

+
User-created cable

*6 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block             
Conversion Adapter, refer to Cable Diagram 8A.

The cable length 
must be 500m or less.

8B User-created cable
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8A)

8B)

Legend Name Notes

(1)
COM Port Conversion Adapter by Pro-face

CA3-ADPCOM-01

(2)
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01

• The cable length must be 500m or less.

• The cable length must be 500m or less.
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8C)

Legend Name Notes

(1)
Online Adapter by Pro-face

CA4-ADPONL-01

(2)
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01

• The cable length must be 500m or less.
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8D)

Legend Name Notes

(1)
Online Adapter by Pro-face

CA4-ADPONL-01

• The cable length must be 500m or less.
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8E)

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear  of the Display as shown in the table below.    

• The cable length must be 500m or less.

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON
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8F)

Legend Name Notes

(1)
RS-422 Terminal Block Conversion Adapter by Pro-face

PFXZCBADTM1
*1

*1 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block             
Conversion Adapter, refer to Cable Diagram 8A.

• The cable length must be 500m or less.
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5.9 Cable Diagram 9

9A)

Display

(Connection Port)
Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
ST  (COM1)
LT3000 (COM1)
IPC*2

PC/AT

*1 All GP4000 models except GP-4100 series and GP-4203T

*2 Only the COM port which can communicate by RS-232C can be used.

 IPC COM Port (page 7)

9A User-created cable The cable length must be 
15m or less.

GP-4105  (COM1) 9B User-created cable

• The cable length must be 15m or less.
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9B)

• The cable length must be 15m or less.
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5.10 Cable Diagram 10

10A)

10B)

Display

(Connection Port)
Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
ST  (COM1)
LT3000 (COM1)
IPC*2

PC/AT

*1 All GP4000 models except GP-4100 series and GP-4203T

*2 Only the COM port which can communicate by RS-232C can be used.

 IPC COM Port (page 7)

10A User-created cable The cable length must be 
15m or less.

GP-4105  (COM1) 10B User-created cable

• The cable length must be 15m or less.

• The cable length must be 15m or less.
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5.11 Cable Diagram 11

Display

(Connection Port)
Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
ST*2 (COM2)
LT3000 (COM1)
IPC*3

*1  All GP3000 models except AGP-3302B

*2  All ST models except AST-3211A and AST-3302B

*3 Only the COM port which can communicate by RS-422/485 (4 wire) can be used.

 IPC COM Port (page 7)

11A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 1000m or 
less.

11B User-created cable

GP3000*4 (COM2)

*4 All GP3000 models except GP-3200 series and AGP-3302B

11C

Online Adapter by Pro-face
CA4-ADPONL-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

11D

Online Adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

GP-4106  (COM1)
11E User-created cable

GP4000*5 (COM2)
GP-4201T (COM1)

*5 All GP4000 models except GP-4100 series, GP-4*01TM, GP-4201T and GP-4*03T

11F

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1

*6

+
User-created cable

*6 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block             
Conversion Adapter, refer to Cable Diagram 11A.

11B User-created cable
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11A)

• 1:1 Connection

• 1:n Connection

Legend Name Notes

(1)
COM Port Conversion Adapter by Pro-face

CA3-ADPCOM-01

(2)
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01

• The cable length must be 1000m or less.
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11B)

• 1:1 Connection

• 1:n Connection

• The cable length must be 1000m or less.
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11C)

• 1:1 Connection

• 1:n Connection

Legend Name Notes

(1)
Online Adapter by Pro-face

CA4-ADPONL-01

(2)
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01

• The cable length must be 1000m or less.
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11D)

• 1:1 Connection

• 1:n Connection

Legend Name Notes

(1)
Online Adapter by Pro-face

CA4-ADPONL-01

• The cable length must be 1000m or less.
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11E)

• 1:1 Connection

• 1:n Connection

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.  

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

• The cable length must be 1000m or less.
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11F)

• 1:1 Connection

• 1:n Connection

Legend Name Notes

(1)
RS-422 Terminal Block Conversion Adapter by Pro-face

PFXZCBADTM1
*1

*1 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block             
Conversion Adapter, refer to Cable Diagram 11A.

• The cable length must be 1000m or less.
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5.12 Cable Diagram 12

Display

(Connection Port)
Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
ST*2 (COM2)
LT3000 (COM1)

*1  All GP3000 models except AGP-3302B

*2  All ST models except AST-3211A and AST-3302B

12A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 1000m or 
less.

12B User-created cable

GP3000*3 (COM2)

*3 All GP3000 models except GP-3200 series and AGP-3302B

12C

Online Adapter by Pro-face
CA4-ADPONL-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 1000m or 
less.

12D

Online Adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

IPC*4 12E

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 1000m or 
less.

12F User-created cable

GP-4106  (COM1)
12G User-created cable

The cable length 
must be 1000m or 
less.

GP-4107  (COM1)
GP-4*03T*5 (COM2)
GP-4203T (COM1)

12H User-created cable
The cable length 
must be 1000m or 
less.

GP4000*6 (COM2)
GP-4201T (COM1)

12I

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1

*7

+
User-created cable

The cable length 
must be 1000m or 
less.

12B User-created cable

LT-4*01TM (COM1)
12J

RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81
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12A)

• 1:1 Connection

• 1:n Connection

*4 Only the COM port which can communicate by RS-422/485 (2 wire) can be used.

 IPC COM Port (page 7)

*5 Except GP-4203T

*6 All GP4000 models except GP-4100 series, GP-4*01TM, GP-4201T and GP-4*03T

*7 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block             
Conversion Adapter, refer to Cable Diagram 12A.

Legend Name Notes

(1)
COM Port Conversion Adapter by Pro-face

CA3-ADPCOM-01

(2)
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01

• The cable length must be 1000m or less.
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12B)

• 1:1 Connection

• 1:n Connection

• The cable length must be 1000m or less.
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12C)

• 1:1 Connection

• 1:n Connection

Legend Name Notes

(1)
Online Adapter by Pro-face

CA4-ADPONL-01

(2)
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01

• The cable length must be 1000m or less.
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12D)

• 1:1 Connection

• 1:n Connection

Legend Name Notes

(1)
Online Adapter by Pro-face

CA4-ADPONL-01

• The cable length must be 1000m or less.
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12E)

• 1:1 Connection

• 1:n Connection

Legend Name Notes

(1)
COM Port Conversion Adapter by Pro-face

CA3-ADPCOM-01

(2)
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01

• The cable length must be 1000m or less.
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12F)

• 1:1 Connection

• 1:n Connection

• The cable length must be 1000m or less.
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12G)

• 1:1 Connection

• 1:n Connection

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.     

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

• The cable length must be 1000m or less.
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12H)

• 1:1 Connection

• 1:n Connection

• The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS 

connector. Do not use it for other devices.

• In COM on the GP-4107, the SG and FG terminals are isolated.

• The cable length must be 1000m or less.
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12I)

• 1:1 Connection

• 1:n Connection

Legend Name Notes

(1)
RS-422 Terminal Block Conversion Adapter by Pro-face

PFXZCBADTM1
*1

*1 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block             
Conversion Adapter, refer to Cable Diagram 12A.

• The cable length must be 1000m or less.
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12J)

• 1:1 Connection

• 1:n Connection

Legend Name Notes

(1)
RJ45 RS-485 Cable (5m) by Pro-face

PFXZLMCBRJR81

• The cable length must be 1000m or less.
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6 Supported Device

Range of supported device address is shown in the table below. Please note that the actually supported range of 

the devices varies depending on the External Device to be used. Please check the actual range in the manual of 

your External Device.

6.1 Micro/Premium/Twido/Quantum/Momentum Series

This address can be specified as system data area.        

6.2 FCN/FCJ Series

This address can be specified as system data area.        

Device Bit Address Word Address
32

bits
Notes

Coil 000001 - 065536 000001 - 065521

or

*1

*1 High and low relationship of the stored data is specified by the [Double Word word order] setting of [Device                  
Setting].

"4.1 Setup Items in GP-Pro EX" (page 46)

 

Discrete Input 100001 - 165536 100001 - 165521  *2

*2 Write disable

Input Register ----- 300001 - 365536  *2

Holding Register
400001,00 - 
465536,15*3

*3 An access method at the time of Bit Set varies depending on the [Rest of the bits in this word] setting of [Device                      
Setting].

- Clear................

- Do not clear .... 400001,00 - 465536,15

400001 - 465536  

Device Bit Address Word Address
32

bits
Notes

Coil 000001 - 009984 000001 - 009969

or

*1

*1 High and low relationship of the stored data is specified by the [Double Word word order] setting of [Device                  
Setting].

"4.1 Setup Items in GP-Pro EX" (page 46)

 *2

*2 The device access range of the External Device is spcified as 1 to 9999, that of the Display, however, as up to                     
9984, since the Display device is accessible in 16-bit units.

Discrete Input 100001 - 109984 100001 - 109969  *2 *3

*3 Write disable

Input Register
300001.00 - 
309999.15

300001 - 309999  *3

Holding Register
400001.00 - 
409999.15

400001 - 409999  
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6.3 Supported Function Code

Below is the list of Supported Function Code.

6.4 IEC61131 address syntax

The following table gives the equivalences between the Modbus syntax and the IEC61131 syntax.

Function Code (Hex) Description

FC01 (0x01) Reads the ON/OFF status of coils (0X references) in the slave.

FC02 (0x02) Reads the ON/OFF status of discrete inputs (1X references) in the slave.

FC03 (0x03) Reads the binary content of holding registers (4X references) in the slave.

FC04 (0x04) Reads the binary content of input registers (3X references) in the slave.

FC05 (0x05) Forces a single coil (0X references) to either ON or OFF

FC06 (0x06) Presets a value into a single holding register (4X references).

FC15 (0x0F) Forces each coil (0X references) in a sequence of coils to either ON or OFF.

FC16 (0x10) Presets values into a sequence of holding registers (4X references).

• FC15 / FC16 will be used for writing. In case if the connected controller do not support these 

function codes, then FC05 / FC06 will be used.

Device

Modbus address syntax IEC61131syntax

Format

0-based 1-based

Format Range
First 

element
Range

First 

element
Range

First

 element

Coil 000001+i
i=0 to 
65535

000001 %Mi
i=0 to 
65535

%M00000
i=1 to 
65536

%M00001

Discrete 
Input

100001+i
i=0 to 
65535

100001 - - - - -

Input register
(word)

300001+i
i=0 to 
65535

300001 - - - - -

Input register
(word bit)

300001+i,j
i=0 to 
65535
j=0 to15

300001,00 - - - - -

Holding 
register
(word)

400001+i
i=0 to 
65535

400001 %MWi
i=0 to 
65535

%MW00000
i=1 to 
65536

%MW00001

Holding 
register
(word bit)

400001+i,j
i=0 to 
65535
j=0 to15

400001,00
%MWi:
Xj

i=0 to 
65535
j=0 to 15

%MW00000:
X00

i=1 to 
65535
j=0  to15

%MW00001
:X00
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• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"

• The two areas 100000 and 300000 are not accessible with the IEC syntax.

• Once you change the project which you have setup Discrete Input Register to IEC 61131 Syntax, 

the address will be undefined.
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7 Device Code and Address Code

Use device code and address code when you select "Device Type & Address" for the address type in data displays.

7.1 Micro/Premium/Twido/Quantum/Momentum Series

7.2 FCN/FCJ Series

Device Device Name
Device Code

(HEX)
Address Code

Coil 0 0080 Value of (word address - 1) divided by 16

Discrete Input 1 0081 Value of (word address - 1) divided by 16

Input Register 3 0001
Value of word address from which 1 is 
deducted

Holding Register 4 0000
Value of word address from which 1 is 
deducted

Device Device Name
Device Code

(HEX)

Address Code

Coil 0 0080 Value of (word address - 1) divided by 16

Discrete Input 1 0081 Value of (word address - 1) divided by 16

Input Register 3 0001
Value of word address from which 1 is 
deducted

Holding Register 4 0000
Value of word address from which 1 is 
deducted
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8 Error Messages

Error messages are displayed on the screen of Display as follows: "No. : Device Name: Error Message (Error 

Occurrence Area)". Each description is shown below.

Display Examples of Error Messages

"RHAA035: PLC1: Error has been responded for device write command (Error Code: 2 [02H])"

Item Description

No. Error No.

Device Name
Name of External Device where error occurs. Device name is a title of External Device set 
with GP-Pro EX. (Initial value [PLC1])

Error Message Displays messages related to the error which occurs.

Error Occurrence Area

Displays IP address or device address of External Device where error occurs, or error codes 
received from External Device.

• IP address is displayed such as "IP address(Decimal): MAC address( Hex)".
• Device address is diplayed such as "Address: Device address".
• Received error codes are displayed such as "Decimal[Hex]".

• Refer to your External Device manual for details on received error codes.

• Refer to "Display-related errors" in "Maintenance/Troubleshooting Guide" for details on the error 

messages common to the driver.
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